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What is a Brand?

1.1

BRAND FOUNDATION

A brand is the total of all the experiences anyone has with Hope College. It is different

for each person, whether they are a student, alumnus/a, faculty, staff or donor.

Overview

Consciously developing and choosing a brand identity is

a powerful way to build and strengthen connections with
all of our constituents. By becoming more thoughtful and
consistent about what is most important and relevant about
Hope College, we can all pull together. We speak with a

stronger voice. We make the most of our resources.
The process of branding asks central questions, such as:

> How is Hope distinctive?

> How does Hope’s mission and vision guide our brand?

> What about Hope is most important and compelling
to those we serve—students, parents, alumni/ae, friends
of the College, our community?

> What about Hope is most important and compelling
to those who provide service—faculty, staff,

administrators?

A successful brand must honestly reflect who we really are
as a college. It should communicate what matters most,

powerfully and persuasively.

Contained within these guidelines are tools to communicate
Hope’s brand and story. They include a bit of background
about how this brand was developed, direction and
rationale for using elements of the brand platform, and
examples of communications Hope has created using the

new brand identity.

We live our brand.

Because a brand is the total of all the experiences someone
has with Hope College, any of us who represents Hope
(student, staff, alumnus/a or employee) shapes the College’s
reputation and how others experience it. The success of our

brand is up to us.

While marketing and advertising are the most prominent
representations of the brand, the visitors we talk with, the
students we assist, the phone calls we answer, are equally

important, if not more important.

Hope is a welcoming place because we make it so—saying
hello as we walk the campus, opening doors for others,
offering a warm drink to visitors coming in from the cold,

helping and caring for one another.

The College’s reputation for excellence in teaching and
student outcomes rests on the dedication of each of our
faculty members and those who support them. The
dedication our students bring to campus exemplifies the
value they place on education and an understanding of their

impact on the world.

Our great traditions of the Pull, Nykerk, Dance Marathon
and others rely on the continued gifts of thousands of
hours by students, staff and faculty. Championship athletic
teams with scholar-athletes succeed only with the shared
commitment to athletic and academic excellence among

coaches, athletics, faculty and staff, and the community.

We are an intentional community, who make careful choices
in the work we undertake and the decisions we make. We
are thoughtful in our use of the resources available to us

be they knowledge, relationships, facilities or our physical

environment. We seek sustainability in all endeavors.

In short, our words and deeds continue to bring the
Hope brand to life. This brand platform gives us all
communication tools, empowering us to express the

Hope brand in our words and actions.



Brand Story

Out of faith and charity,
Hope College was born.

Hope’s story begins with the October 1851 creation of the
Holland colony’s “Pioneer School.” The Pioneer School
eventually evolved into “The Holland Academy” and then
the college as the community’s educational needs progressed

from elementary to secondary to college.

The Pioneer School was founded with support from the
Reformed Church in America to educate the community’s
children in the context of the Christian faith. The Rev. A.C.
Van Raalte wanted Holland’s children to receive education
with a Christian character—an option not guaranteed

through state-supported schooling.

The Pioneer School found its first home in a building called
the “Orphan House”, originally slated to house parentless
children within the community. Through their charity

and generosity, surviving Holland colonists adopted all
orphaned children into their own homes allowing the

building to be repurposed for education.

But that is only the beginning. . . .

BRAND FOUNDATION

Since that time Hope’s mission and vision are shaped by

its Christian faith, ecumenical ideals, and programs of
recognized excellence in the liberal arts. Still affiliated with
the Reformed Church in America, an originally Dutch
denomination with traditional strength in the Northeast,
Hope has become a nationally recognized, outstanding

liberal arts college.

Like most church-related private colleges and universities,
Hope College flourished through its Reformed connections
until the 1970s. As Hope’s original base changed, the
college had to introduce itself to new people in new
geographical regions. The student body became more
religously and culturally diverse. A shared identity could no

longer be implicit or unconscious.

Each area of the college developed its own communications
for the constituents it served, such as development,
admissions and alumni relations. Gradually, Hope
leadership became aware of the need to connect image

and messaging, to raise Hope’s visibility, to become more
ecumenical, and promote its excellence in a crowded

educational marketplace.

The mission of the College is to recruit and educate world
citizens within a Christian context. Hope seeks to focus and
broaden its outreach nationally and internationally.

A clearly-articulated brand position will support this goal.



Brand Story

An authentic brand flows from the mission,

vision and lived experience of the college.

The mission of Hope College is to educate students
for lives of leadership and service in a global society
through academic and co-curricular programs of
recognized excellence in the liberal arts and in the

context of the historic Christian faith.

BRAND FOUNDATION 1.3

Vision Statements
> to pursue truth so as to renew the mind,

enrich the disciplines, and transform the culture

> to inspire passion for knowledge that grows

into understanding and bears fruit in wisdom

> to be an exceptional liberal arts college that provides

excellent professional and pre-professional programs

> to be a leading Christian college, ecumenical in character

and rooted in the Reformed tradition

> to enhance education through residential

community and superior co-curricular programs

Core Values

> to offer rigorous academic programs

> to contribute to the body of knowledge

in the academic disciplines
> to nurture vibrant Christian faith
> to be a caring community

> to foster development of the whole person —

intellectually, spiritually, socially, physically

> to be wise stewards of resources



Brand Promise

The brand promise defines what
Hope College intends to be and the
experience an individual can expect to

have when engaging with the institution.

The brand promise is for internal use and

is different than Hope’s mission statement.

BRAND FOUNDATION 1 .4

Hope College’s Promise:

Hope College inspires students to be

fully alive in mind, body and spirit

through an exceptional liberal arts education
and a community grounded

in a vibrant Christian faith.

Successful brand communications must honestly reflect who
we are as an institution. The brand promise is inspired by
the College’s mission and vision. It is an internal statement
shared by our administration, faculty and staff that defines
what Hope College promises to be and the experience an
individual can expect to have when engaging with the insti-

tution. It is against this standard we will measure our work.

As a community and an institution, Hope College has many
stories to tell. This brand promise guides and inspires us as
we tell Hope’s story, now and in the future. It serves as

a touchstone for planning, communications, marketing and
evaluation. But it is strictly an internal guiding statement

never to be published in marketing materials.



Brand Attributes

Brand attributes are key words and phrases
that describe Hope College as it is and

aspires to be. This language is used to be clear

and relevant to the College’s key audiences.

Rare Combination
Rigorous academics and vibrant, inviting Christian
faith combined to prepare students to live within a

global society.

Picturesque and Welcoming Community

A historic campus, located just blocks from award-
winning downtown Holland, and part of an engaging
and increasingly diverse community that approaches

relationships with respect, compassion and support.

Close Student-Faculty and
Student-Staff Relationships

Masterful teachers and talented researchers in small
classes and one-on-one collaboration, with a strong
commitment to students’ personal, intellectual, social

and career development.

Christian Character

Offers many voluntary opportunities to grow one’s
faith in an inviting Christian community, while seeking
to engage the whole person through academics and

co-curricular programs.

Nationally Recognized Academics
Known for undergraduate research, scholarship,

preparation, and life-shaping experiences.

1.9

BRAND FOUNDATION

These words and phrases originated from a March

2011 brand workshop, with input from the January 2011
surveys of staff, faculty, prospective and current students.
These attributes were refined through consultation with

administrators, alumni, trustees, faculty and staff.

Holistic Approach

Liberal arts and pre-professional programs with

high academic standards and exceptional career
opportunities. Holistic approach has been lauded for
character, preparedness, service, and life-changing

experiences for students.

Championship Athletics
Nationally competitive tradition with scholar-athletes,
quality facilities, and a community that supports Hope

teams.

Remarkable Facilities
World-class facilities that support the high caliber
research, athletic, social and spiritual opportunities

offered throughout the campus experience.

Vibrant Student Life

Commitment to the whole person, in mind, body and
spirit, with an emphasis on cultivating relationships
through award-winning social activities and unique
traditions within a thriving and safe residential

community.



Brand Concept - Fu||y Alive BRAND FOUNDATION 1.0

By understanding the foundation for the Deeply ecumenical, the “Fully Alive” concept can

creative concept, you will be better able tap wisdom and spiritual values from diverse religious

to use it with confidence and create new perspectives that teach mindfulness, inquiry, and living
materials that consistently embody the brand fully in the present. If we can reflect upon what connects
us to life, love, faith, hope , peace, we perceive where it is

. o o God is most available to us, or more truly, where we are
The “Fully Alive” concept expresses the mission of Hope
. most available to God.
College, the experience of Hope students, and the

aspirations for its alumni. The College’s national reputation ’
4 o o Hope graduates are educated to think about life’s
for academic excellence and its vibrant Christian
. ~ most important issues with clarity, wisdom and a deep

atmosphere attract students who want an education that is

understanding of essential values of the Christian faith.
life-changing and empowering.

They are prepared to communicate effectively, bridge

. ) boundaries that divide human communities, and to be

Hope’s “fully alive” theme permeates all areas of life for

“World Christians.” They are agents of hope who live
Hope students and alumni and reflects the openness,

faithfully into their vocation. Hope graduates make a
grounding, and depth that characterize a Hope education.

difference in the world.
Students and graduates:

> explore who they are as people as well as
future professionals

> forge relationships on a deeper level that take
life seriously

> integrate spirituality into creativity and find a
common ground

> understand how their beliefs can be lived out within

a complex global society



Key Messaging

1.7

BRAND FOUNDATION

Key messages, which are based on the brand attributes, are the most important talking points

or copy points when communicating with Hope’s constituents. They differ according to the

audience, and the nature of their relationship with Hope and what they may value as a result.

People’s engagement with Hope, and therefore their
perspective and needs, change over time. They will
want more or different things from the College as

their relationship evolves. Those of us responsible for
communications must understand the dynamic nature
of our audiences—prospective students, current students,
parents, alumni, donors, faculty, staff, community

members—and how to best connect with them.

Choosing messages

Key messages, which are based on our brand attributes, are
the most important talking points in communicating with
Hope’s contituents. In choosing messages, we must keep in
mind the audience and what they value. Think about Hope
from their perspective. To be most effective, consider what

messages wil resonate as important and relevant.

We want our Hope community to understand “Hope lives

in me”. Our culture and offering is inspired by an education
that propels everyone forward towatds a future with purpose.
It will be also be important to express the brand and
messages In ways that resonate with a more broadly holistic

and spiritual expression of the benefits of Hope.

Key messages that support our brand attributes

> Hope is a rare combination of nationally recognized
academic excellence and its vibrant Christian atmosphere.
At Hope, one’s personal faith is a choice, and voluntary

chapel is full to capacity.

> Hope is a friendly and welcoming community where faculty,

staff and students come to know and care about one another.

> Our 13:1 student-to-faculty ratio offers close collaboration
and mentoring by faculty. Masterful teachers and talented
researchers are committed to enabling students to achieve
their best.

> With more than 80 majors in liberal arts and pre-
professional programs, the college has high academic
standards and exceptional placement opportunities. Our
holistic approach has been lauded for character, preparedness,

service and life-changing experiences for students.

> A research powerhouse, Hope’s faculty-student
collaboration is funded by more than $5 million in active
grants. The college holds more grants for faculty-student
research from the National Science Foundation than any
other undergraduate college in the country. Research
Corporation ranks Hope at the top of their list for institutions

receiving funding for undergraduate research.

> Hope is the only private, liberal arts college to have
national accreditation in art, dance, music and theatre.
The arts community is active and diverse, including

20-plus performing ensembles.

> Our 3,200 students come from more than 40 states and
territories and 30 different countries. We are a leading
college for Fulbright Scholars, and our students can look
forward to attending their first choice of graduate and

professional schools.

> We have a time-honored championship athletic tradition
with scholar-athletes and a community that supports
college teams. Hope has received the Commissioner’s

Cup of the Michigan Intercollegiate Athletic Association
for an unprecedented 12 consecutive years through the
2011-12 school year. Hope also sponsors several club sport

opportunities and has an active intramural program.

> Hope has a beautiful, safe and historic campus, just blocks
from the charming town of Holland, Michigan. The college
has invested significantly in having the best facilities, and it is

an increasingly culturally diverse community.



Brand Architecture BRANDFOUNDATION 1.8

The brand architecture provides the structure for strategically managing how Hope College
and its various units represent themselves to their audiences. It will promote consistency in

application and define an understandable relationship and hierarchy.

Core Brand Brand Extensions
The core brand is the consistent expression of the These are defined as integral components of the
College’s brand promise, brand attributes and core Hope brand with a distinct focus or initiative
institutional personality based on the use of the that directly supports the College’s mission.
logo, logotype, and brand identity. Examples:

Academic Support Center

Unit Identifier
Center for Faithful Leadership

Encompassed fully by the core brand, unit identifiers
Mellon Scholars Program

are used for those academic, administrative, and
Van Raalte Institute

operational areas organized by department, office or

work group. Sub-Brands

Examples: Sub-brands are directly linked to the core brand but
Division of Arts and Humanities require some differentiation of expression or applica-
Department of Chemistry tion because they serve a distinct service or need.
International and Multicultural Education Examples:

Institutional Research Athletics (Download the Athletics Sub-Brand

Office of the Registrar Guidelines at hope.edu/brand)

Office of Student Life

Independent Brands

These brands represent a complete departure from
the core brand identity, establishing independent
identities that clearly articulate their distinct
relationship to Hope College.

Example:

Haworth Inn and Conference Center




|nteg rated Marketing BRAND FOUNDATION

The Integrated Marketing Planning Team (IMPT) has been working to advance the college’s strategic

marketing efforts on several fronts. These efforts have included the following:

+  Defining a resource team (Integrated Marketing) to lead our efforts in implementing the redefined Hope
brand throughout the campus.

«  Define goals for the the future.

+  Providing some tactical help on specific college marketing initiatives.

«  Considering the makeup of the IMPT and looking toward expansion.

With a presidential transition, we believe an interim approach makes more sense than committing to a
structure that will undoubtedly change. We've asked four persons who have been involved in this process to
dedicate up to fifty percent of their time to the marketing effort while also maintaining their current roles and

responsibilities. We have also hired two part-time communication specialists to join this team.

To sustain our current program, we will be providing resources to backfill for close to fifty percent of the team

members’ current job responsibilities.

Bill Vanderbilt, Admissions

Dave Vanderwel, Advancement

Co-Chairs of the Integrated Marketing Planning Team

CONTACT

Carol Fritz, Admissions Samantha Bruin, Communication Specialist
Messaging Design

fritzc@hope.edu bruin@hope.edu

616.395.7045 616.395.7052

Scott Travis, Alumni & Parent Relations Jason Cash, College Advancement
Production Web

travis@hope.edu cash@hope.edu

616.395.7046 616.395.7047

Rebecca Robrahn, CIT Craig Tommola, Communication Specialist
Design Web

robrahn@hope.edu tommola@hope.edu

616.395.7044 616.395.7048
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Logo | Icon Overview LocosTaNDARDs 2.1

This anchor was adopted as a symbolic icon and appears in the center
e anchor has become synonymous P Y PP
with Hobe and has roots in the Colleae’s of the rose window, and other stained glass in Dimnent Chapel. It is
P 9 also the center of the college seal, the name of the college newspaper,
legacy. The metaphor originated from and adorns the lawn in front of Graves Hall.
an observation the Rev. Van Raalte

made regarding the Pioneer School: The logo’s anchor is drawn from the one in front of Graves Hall.
The triangular border suggests the principles of mind, body, spirit
associated with the College’s Christian heritage. The lines of the
rounded triangle and anchor co-mingle.

“This is my anchor of hope
for this people in the future.”

Please note that this version of the anchor icon has been revised from
the previous version. The difference is that the previous icon is a
reversed version of the anchor that has a thin outline. This icon may

no longer be used in any application.

Use of the icon by itself has restrictions. Please refer to Appendix A.4
for further guidelines on this type of usage.




Logo | Icon and Logotype

This is the primary logo for Hope College.

|t consists of two parts: the name of the

college, or logotype, and the anchor icon.

This is an update of the previous logo.

LOGO STANDARDS 2 o 2

The logotype uses two different typefaces. ‘Hope’ is set in Clarendon
Bold, using both upper and lowercase letters. ‘College’ is set in all

uppercase letters and uses Verlag Book.

Through consistent use of the Hope College logotype and editorial

standards, Hope’s overall brand will be strengthened.

For further logo color specifictions see Section 2.7.

& Hope COLLEGE

icon

logotype

logo



Configuration | Horizontal LOGOSTANDARDS 2.3

The configuration of the horizontal The spacing for the logo is based on x, which is equal to the width of

. the ‘O’ in ‘College’. The distance between the icon and the logotype
logotype and icon appears below. , _
and the two words of the logotype is //2x. The the baseline of the
logotype aligns with the bottom of the anchor icon. The top of the ‘H’
in ‘Hope’ is exactly //4x from the top of the icon. The top of the ‘C’ in
‘College’ lines up with the top of the lowercase letters in ‘Hope’. These

exact dimensions of spacing must be consistent in all applications of

this logo version.

con logotype

logo

Download horizontal logo at:

0 hope.edu/brand



Configuration | Vertical

You may find that the horizontal logo
version is not the best choice for some
applications because it renders too small
or fits awkwardly in the space. Below is the
vertical version, designed to accommodate

other space or size requirements.

LOGO STANDARDS 2 o4

This version may be used only if the layout does not permit

use of the horizontal logo version.

Notice that in this version, the ‘H’ in Hope is aligned with the top of
the anchor icon. The word ‘College’ also has more tracking between
the letters to span the width of the icon and the word ‘Hope’ at the top.
The spacing between the icon and ‘Hope’ is consistent with the

horizontal version of the logo. The spacing between the icon and

‘Hope’ and the word ‘College’ is «.

Download vertical logo at:

0 hope.edu/brand



Spacing and Dimensions | Clearspace LOGOSTANDARDS 2.9

The Hope logo must always have a clear Also, be careful not to place the logo too close to the edge of the

, a folded ed «
space around it, where no other elements paper, a folded edgt ora cu
appear (no typography, other logos, graphics

The clear area for both horizontal and vertical is the height of the
or photos may intrude upon the logo.)

“O” 1n ‘College’.

HORIZONTAL LOGO

O oo

VERTICAL LOGO



Spacing and Dimensions | Minimum Size  Locostanparos 2.6

The minimum sizes for the Following The smallest the icon size should be is .3” high. When using a
logo variation without the icon (see A.2), the type in ‘College’

logos are based on legibility of the icon
should be no smaller than 7 pt.

or the text.

777777 Minimum size: (@ Hope 7777777 Mmzmum size:
& Hope COLLEGE iy colleae |

HORIZONTAL LOGO VERTICAL LOGO



Color Specifications | Primary Usage LOGOSTANDARDS 2.7

The two colors of the logo are the primary =~ TWOCOLOR

Hope College colors. These colors apply to

both the horizontal and vertical versions of & Hope COLLEGE

the logo.

Under no circumstances may any other
colors or tints of a color be used. These
colors apply to all versions of the logo ONECOLOR

including special use.

& Hope COLLEGE

The two color method should be used

whenever possible on a white, cream,

or other light-colored background

(20% or less tint). The colors used @ H

are specific and restricted: the icon op e C O L L E G E
in Hope Orange (PMS 166), and the

logotype in Hope Blue (PMS 289).

This is done for brand recognition

and consistency. BLAC
LACK

One Color and Black

When the entire project is one color, @ H

a one color logo may be used. The Op e C O I_ L E G E
acceptable colors are either Hope

Orange (PMS 166) or Hope Blue (PMS

289). An all black version may be used

for black and white projects. Always

choose the color version that provides

the greatest contrast and readability.



Color Specif ications | Reversals LOGOSTANDARDS 2.8

When reversing the logo out of a color REVERSAL IN ONE COLOR - WHITE
background, be sure the logo is large
enough for the wordmark and symbol to

be read clearly, with sufficient contrast.

& Hope COLLEGE

Reversed logo colors

The one color (white) logo may be reversed out

of any primary or secondary color with the
exception of PMS 106 (Cottage Yellow) and PMS
317 (Macatawa Mist). See Sections 3.1-2 for more ~ REVERSAL IN TWO COLORS - HOPE ORANGE AND WHITE
information about primary and secondary colors.  FOR HOPE BLUE BACKGROUND ONLY

The two color (PMS 166 and white) logo may
be reversed out of a PMS 289 (Hope Blue)
background. This is the only background color
permitted for use with this type of reversal.

Hope COLLEGE

Reversing out of a shape of color

When reversing out of a square or rectangular
shape of color, the area of color for the logo
reversal must be at least twice the clearspace for
the logo (please see Section 2.5 for clearspace REVERSAL OUT OF A COLOR FIELD
specifications). The logo may not be reversed out

of any shape other than a square or rectangle. 8

Reversing out of a band of color
When using a band of color for logo reversal, & Hope CO L LE G E

it must span the entire width of the page layout.

The clearspace for the logo when placed within

a band of color must be at least twice the size
of the letter “O” in the logo on top, bottom,
and on each side. REVERSAL OUT OF ABAR

& Hope COLLEGE




Color Specif ications | With Screens LOGOSTANDARDS 2.9

The logo may appear in one or
two colors when using a background

of screened color.

Only recommended tints of a color may be used
as a background color. See Section 3.3 for
further details.

If the logo is placed on top of a background color
screened at 20% or less, the logo must print in its

solid color form.
If the logo appears on a dark background
color screen of 50% or more, the logo must

be reversed.

Logo usage against screens between 20%

and 50% is not recommended.

This applies for all logos within the system.

TWO-COLORLOGO ONA 20 PERCENT SCREEN OF COLOR

" Hope COLLEGE

ONE-COLORLOGO ONA 20 PERCENT SCREEN OF COLOR

& Hope COLLEGE

ONE-COLORLOGO (BLACK) ON A20 PERCENT SCREEN OF COLOR

& Hope COLLEGE

REVERSED LOGO ON A 50 PERCENT SCREEN OF COLOR

& Hope COLLEGE




Color Specifications | With Photography Loco sTANDARDs 2.10

When placed on top of a photo contrast REVERSED LOGO ONAPHOTO

and color should be carefully considered.

If the logo is placed on top of or reversed @ Hope COLLEGE

out of a photograph, the area surrounding
the logo must have very little pattern

or texture and the background should
provide distinct contrast so the logo
appears legible and stands out noticeably.
The logo should be of substantial size to
identify the item clearly. The logo can
print in one or two colors or be reversed in

white.

TWO-COLORLOGO ONAPHOTO

« Hope

O | | EGE




COlOI’ Specifications | Unacceptable Usage LocosTANDARDs 2.11

Whether the logo prints in one

or two colors or is reversed,

it must appear against a background

of sufficient contrast to provide clarity.

Be sure to follow the color guidelines for

logo specification and application.

& Ho OLLEGE OLLEGE

Do not use unacceptable colors for the entire
logo or for parts of the logo. This includes
unacceptable use of brand colors. Do not add any
effects such as bevels or drop shadows to logo. See

Section 2.7 for logo color specification.

& Hope COLLEGE

Do not reverse the logo out of unacceptable colors.
Do not reverse only part of the logo out of a color. See

Section 2.8 for logo reversal specification.

Do not reverse the logo out of a tint or screen lighter
than 50 percent. Do not use a color or black logo on
a tint or screen 50 percent or greater. See Section

2.9 for logo color specification with screens.

Do not place the logo on busy backgrounds

of either photography or vector art. Do not

reverse the logo out of a light-colored background.
Do not put a color or black logo on a dark
background, unless there is sufficient contrast.
See Section 2.10 for logo specification on
photography or vector art.



Presidential Seal LOGO STANDARDS 2. 12

Hope’s name and seal both originate from The Presidential Seal contains the anchor icon, which has become
an observation the Rev. Van Raalte made synonymous with Hope (see section 2.1). The Seal should be
considered only for official documents of the College. Examples
regarding the Pioneer School: “This is my might include diplomas, certificates, legal documents, and special
anchor of hope for this people in the future.” commmunications from the Office of the President. Permission

The symbolism follows the Epistle to the from The Office of the Registrar must be sought for other uses.

Hebrews 6:19, “We have this hope, a sure Color Guidelines

and steadfast anchor of the soul... Overall, always choose the color version that provides the greatest

contrast and readability.

One color and reversals are the only color options, since the seal
can not be reproduced using two colors. Only Hope Blue (PMS
289) or black are the preferred one-color applications. Black may
be used if necessary but is not the preferred color choice. The
seal may be reversed out of a color in using white. No tints or

transparencies of the seal are permitted in any application.




BRAND IDENTITY

Color Palette 3.1

Typography 3.5
Photography 3.8



Color Palette | Primary Colors BRAND IDENTITY 3.1

Orange and Blue are Hope’s primary Orange or Blue must be present in every layout with the exception
of black and white media. These colors can be used in a variety of

brand colors.

elements, including but not limited to type, photography, texture,
graphics and the logo.

Hope Orange Hope Blue

PMS 166 C PMS 289 C
0/74/100/0 CP 100/76/10/65 CP
PMS 166 U PMS 289 U
0/57/84/2 UP 97/63/13/41 UP
HEX# F46A1F HEX # 002244

R: 244, G:106, B: 31 R:0,G:34,B: 68

C/MJYIK

C: Coated Spot Color

CP: Coated Process Color
U: Uncoated Spot Color
UP: Uncoated Process Color

Download color palette swatches at:

0 hope.edu/brand



COlOI’ Pa|ette | Secondary Colors

The secondary color palette is based on colors in the rose

window of Dimnent Chapel and also reference elements

unique to the Hope experience.

Eight colors were chosen as complements for each of the main school

colors. Neutrals round out the set.

BRIGHTS

Veneklasen Brick Tulip Orange
PMS 130 C

PMS 1535 C

8/75/100/40 CP 0/30/100/0 CP
PMS 1535 U

10/52/92/24 UP 0/27/86/0 UP
HEX# 91420E

R: 145, G: 66, B: 14

Pine Grove Green  Lake Michigan Blue

PMS 568 C PMS 646 C
89/11/48/47 CP 73/30/3/10 CP
PMS 568 U PMS 646 U
91/13/62/23 UP 62/29/10/4 UP

HEX # 00685B HEX # 5482AB
R:0, G: 104, B: 91 R: 84, G:130, B: 171

Download color palette swatches at:

0 hope.edu/brand

Cottage Yellow

PMS 129 U

HEX# FoOABoO
R:240,G:171,B: 0

HEX# F7E654
R: 247, G: 230, B: 84

Stained Glass Blue

89/0/20/0 CP

67/0/18/0 UP
HEX # 00BoCA
R:0, G:176, B: 202

Spring Fling Green
PMS 382 C
28/0/92/0 CP

PMS 380U
15/0/65/0 UP

HEX # BED600
R:190,G: 214, B: 0

Macatawa Mist
PMS 317 C
24/0/7/0 CP

PMS 317U
32/0/14/0 UP

HEX # BBE7Es
R:187, G: 231, B: 230

BRAND IDENTITY

NEUTRALS

Black River Black
PMS Process Black C
o/o/o/100 CP

PMS Process Black U
0/0/0/100 UP

HEX # 000000
R:0,G:0,B:0

Graves Hall Gray
PMS Cool Gray 11 C
48/36/24/66 CP
PMS Cool Gray 1 U
30/17/8/53 UP

HEX # 4D4F53
R:77,G:79,B: 83

C/MJYIK

C: Coated Spot Color

CP: Coated Process Color
U: Uncoated Spot Color
UP: Uncoated Process Color

3.2



Color Palette | Tints BRAND IDENTITY  &3.&3

Tints of the primary and secondary colors Each color has a range of tints that may be used. The range was
chosen based on several criteria: whether the tints hold true to the
may be used to extend the color palette e ; ) R ]
original color, whether the color is too light for use in print, and its
and for layering purposes. overall aesthetic. Hope Orange (PMS 166) is the only color that may

not be used as a tint.

PRIMARY COLORS  SECONDARY COLORPALETTE

| ]|
| ]
| 4

Hope Orange Veneklasen Brick Tulip Orange Cottage Yellow Spring Fling Green Pine Grove Green
TINTSNOT PERMITTED 100-70% 100-70% 100-30% 100-30% 100-70%, 30-10%

| ] | 1]
mE N mEz

HEN
HEE = a HEN
| )4 A

Hope Blue Lake Michigan Blue Stained Glass Blue Macatawa Mist Graves Hall Gray Black River Black
100-60% 100-10% 100-10% 100-30% 100-10% 100-10%




CO|OI‘ Palette | Color Combinations BRANDIDENTITY 3.4

The primary colors and secondary
complements are intended to be

used either together (analogous color
for a more harmonious look and feel)
or in contrast to each other. These are
suggestions for usage and do not

represent the only combinations.

ANALOGOUS

The examples below show different proportions of these colors
that may be used. Note that one of the primary school colors must
be present in every layout but does not always have to be used
dominantly. A layout is defined as either the entire piece (if it is
single page such as an ad) or each cover, spread or web page

within a multipage document or website.

CONTRASTING




Typography | Print and Graphic Text

The typefaces for Hope College are Verlag,

Baskerville and Clarendon. Verlag is a sans
serif, Baskerville is a serif and Clarendon is

a slab serif.

Headlines, Display and Callout

The primary typeface for headline, subheads

and callouts is Verlag. It can also be used as a
display typeface. Verlag is a typeface based on

Futura and other geometric type styles.

Verlag

Body Copy and Callout

The primary typeface for body copy and text
on letterhead is Baskerville. It can also be used
as a callout. Baskerville is a serif typeface and
provides balance to the more rigid geometric

typeface.

Baskerville

Display Only

The primary display typeface is Clarendon BT.

Clarendon is a slab serif typeface. Its curvy
lines are a nice contrast to sans serif typefaces
and are a powerful choice for graphic typog-
raphy. Display type refers to the use of type at
large sizes. See further examples on sections
4.8 and A.8.

Clarendon BT

Request typefaces from:

BRAND IDENTITY

Verlag Extra Light

ABCDEFGHIJKIMNOPQRSTUVWXYZ
abcdefghijklmnopgrstuvwxyz

Verlag Light
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz

Verlag Book

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopgrstuvwxyz

Verlag Bold

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Verlag Black
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Baskerville Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopgrstuvwxyz

Baskerville Italic
ABCDEFGHIFKLMNOPQRSTUVWXYL
abedefghyklmnopgrstuviwxyz

Clarendon Light BT
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqgrstuvwxyz

Clarendon Roman BT
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Clarendon Bold BT
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abedefghijklmnopqrstuvwxyz

Clarendon Black BT
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abedefghijklmnopqrstuvwxyz



Typography | Special Use BRAND IDENTITY 3.0

If a project calls for a script font,

Zapfino is recommended. Use of

the script font should be carefully

considered and used sparingly. ABCDEF?}Z{Z]/QM
Special initiatives requiring a specific NOPQ&SWW

elegance such as a campaign or a formal gala

event invitation would be good examples of
appropriate typeface use. ‘e
ppropriate P M Jfa/ﬂ@&



TYPOQI’aphy | Substitute Fonts

As the number of standard web fonts

is limited and not all computers have
the brand fonts installed, two substitute
typefaces have been chosen for Hope
College: Arial and Georgia. Arial

is a sans serif substitute for Verlag

and Georgia is a serif substitute for
Clarendon and Baskerville. These
versions are to be used for digital
applications such as website, email, and
E-news content and only when absolutely
neccessary in print when primary brand

fonts are not available.

For areas of a digital communication where
typography might be used as a graphic
clement (such as a headline, call-out quote,
drop capital), the official institutional
typefaces are recommended for consistency.
It is important to remember that when used
this way, the type must be converted into a
flat image such as a .jpg, .png, or .gif. This
treatment is not recommended for body copy

or other use where the information is critical

Request typefaces from:

0 hope.edu/brand

BRAND IDENTITY 3.7

Arial Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz

Atrial Iltalic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopqrstuvwxyz

Arial Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopqgrstuvwxyz

Arial Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz



Photography | Overview

Photography is the primary means of
visual storytelling within the portfolio
of brand assets. Images can express
the emotions, aspirations, inspiration,
and transformations of Hope students,
faculty, and staff. Images also visually
reinforce the core brand attributes

of the College.

Today’s digital media require powerful
images to engage and hold a readers
attention. In many cases, a carefully-

selected photo can often say more than

a paragraph of words but serve as a bridge

for an reader’s interest to look deeper.

3.8

BRAND IDENTITY

The goal is to capture the energy and emotion of a moment. People
engaged 1n intense activities, genuine interactions, or spontaneous
reactions can communicate a story. Tip: Instead of subjects looking
directly into the camera, have them look at a point in a different

direction and images will look more natural.

Composition is everything. As a general rule when selecting photo-
graphy, choose images that are tightly cropped around the subject.
Asymmetry, dramatic perspective and uncommon angles all make
for a more powerful photo. Even a mediocre image can be improved
with an interesting crop. Avoid the centered subject surrounded by

lots of empty or dead space.

The best photos have contrast and saturated colors. Avoid flat, under

or over-exposed images.

Hope Photography Archive

Hope College has an extensive photography archive that includes both
topic specific and general brand imagery. For topic/event specific photos
contact Public and Community Relations at 616-395-7860 or prela-
tions@hope.edu. For general brand imagery contact Integrated Market-
ing at 616-395-7150 or marketing@hope.edu.

Custom Photography

The advantage of custom images is the total control of the subject matter
and composition available. But a custom photo shoot also requires careful,
advanced planning and a coordination of numerous elements to ensure a
quality result. Custom photography also requires release forms to be signed
by all subjects for legal purposes. Please contact marketing@hope.edu to

learn more.

Stock Photography

While the advantage is immediate availabilty at a reasonable price, the
downside is the subject matter is generic and not campus- or person-
specific. Because of this, purchased stock photography should not include
people. Use of stock photography should be carefully considered and
used sparingly.



Photography | By Attribute BRAND IDENTITY  ¢3.9

The following photos show how the brand attributes can be expressed through photography.
These examples demonstrate image style and composition. They are included to provide

guidelines for choosing and crafting imagery.

STUDENT-FACULTY/STAFF

NATIONALLY RECOGNIZED ACADEMICS




Photography | By Attribute BrRAND IDENTITY ¢3.10

The following photos show how the brand attributes can be expressed through photography.
These examples demonstrate image style and composition. They are included to provide

guidelines for choosing and crafting imagery.

REMARKABLE FACILITIES

HOLISTIC APPROACH

VIBRANT STUDENT LIFE




Print Examples 4.1-4.16

Digital Examples 4.17



Print Examples | Business Card sranDAppLIcATION 4.1

This application shows how the brand
elements are used for the approved

business card layout.

& Hope COLLEGE

MARKL. DEWITT ‘87

Director of Corporate and DeWitt Student and
Foundation Relations Cultural Center
College Advancement 141 East 12th Street

P.O. Box 9000
616.395.7357 direct Holland, Ml 49422-9000
616.403.5334 mobile hope.edu/patrons

dewittm@hope.edu

2-COLOR BUSINESS CARD FRONT

Order business cards at:

o hope.edu/brand



Print Examples | Letterhead BrRAND APPLICATION 4.2

This application shows how the brand

elements are used for the approved

letterhead layout.

Features of the layout to note:

1. Horizontal, 2-color college logo

2. Hope Orange (PMS 166) used for emphasis

3. Baskerville used for body of text (suggested text size is 10 pt / 15 pt)
See Page 3.7 for information on substitute fonts.

¥
- va”Ab{ i

July 10, 2012

— L0"—>

Miss Jane Jones

The Business School

12 Harrington Place
Greenpoint, New York 00000

Dear Miss Jones:

our brand attributes. The college

Sincerely,

Carol Fritz

enclosed: attributes

o]

This letter is an example of the full block style of letter, which has been adopted as a standard at

Hope College. We have reproduced in line with our Brand Guidelines so that everyone will be familiar
with the format. As you can see, there are no indentations. Everything, including the date and the

complimentary close, begins at the extreme left. This uniformity eliminates several mechanical operations }*
in composing letters. Additionally, this letter is written using Baskerville 11 pt font.

We would like to also take this opportunity to remind those that compose letters and documents of

Enclosed you will find the list of Hope College’s attributes and their descriptions. Incorporating these
concepts enhances individual, departmental and college wide communication with our audiences.

We appreciate all you do for the college. Thank you for your support in keeping the Hope College story
true to its brand. Please contact me with any questions or concerns.

DEPARTMENT OF ECONOMICS, MANAGEMENT & ACCOUNTING
41 Graves Place, P.O. Box 9000, Holland, M1 49422 | 616.395.7000 | hope.edu

i

& Hope COLLEGE " ... —— &

>
Desired

57—
Minimum

s “story” is shared best when keeping the brand attributes in mind.

.57 minimum

T
'

LETTERHEAD

Order letterhead at:

0 hope.edu/brand



Print Examples | Envelope BRAND APPLICATION 4.3

This application shows how the brand Features of the layout to note:

elements are used for the approved 1. Horizontal, 2-color college logo

envelope layout.

€ < Hope coLitce

P.O. Box 9000, Holland, M 49422

#10 ENVELOPE

Order envelopes at:

0 hope.edu/brand



Print Examples | Cover Overview BranDAPPLICATION 4.4

Section 4 presents many examples of how  Triptych Cover
the elements covered in Sections 2 and The- triptych efample is be.st used when communicating tf) an
) ) audience who is encountering Hope College for the first time.
3 can be combined in a layout. These I : . :

t represents an intentional spectrum of our vibrant campus

examp|es do not present the on|y available experience—beautiful facilities, engaged students, dynamic
options for layout. However, there are movement.

several cover options that may be used . ,
P Y Your Moment’ Cover

when the subject matter is appropriate. The Moment example is best utilized when communicating to a
reader that has some knowledge or prior touchpoint with Hope.

Section 4 includes examples of how the The set-up is.nlqore th.ougl?t—provolking .and directly engages the

reader by pairing a situation and question together to demonstrate

brand can be applied. For support in the “moments” that live at the heart of the Hope experience.

creating publications like these please

contact Integrated Marketing (Section 1.9) ~ 'Engaged Student’ Cover
The Engaged Student option is also best utilized when
communicating to a reader that has some knowledge or prior
touchpoint with Hope. The difference in this example is the
questions is paired with photo of a singular student intensely
engaged in an activity showing some spontaneous emotion.
This cover uses a graphic color treatment specific a style of

concept photography within the guidelines.

0 Hope

Center for

Faithful Leadership

Dimnent
Chapel

TRIPTYCH COVER ‘YOUR MOMENT’ COVER ‘ENGAGED STUDENT COVER



Print Examples | Cover - Triptych BRAND APPLICATION 4.

This application shows a suggestion of how  Features of the layout to note:

the brand elements can be used in combi- 1 Use of vertical strips for photo layout

2. Asymmetrical composition with layering

nation to create a “triptych” cover layout. 3. Campus beauty attribute photo

The triptych approach expresses three 4. Full emotion photography and close-cropped photo

aspects of the “Fully Alive” concept - 5. Motion blur photography

6. Transparency with graphic type

ibrant lif d student
vibrant campus fite, ehgaged students, 7. ‘Live It” header paired with ‘spirit’ logotype

and dynamic movement. 8. Hope logo is used on the back

¢ & oo

BROCHURE BACK

e

LAYOUT TIP

- — LLearn it. Love it. Live it.
Suggested — —
applications:
> Brochure cover -
> Poster
> Direct Mail

BROCHURE COVER

¢ o




Print Examp|es | Cover - Your Moment BRAND APPLICATION

This application shows a suggestion of how  Features of the layout to note:

the brand elements can be used in com- 1. Motion blur photography

o . . 2. Use of question messaging
bination to create a “your moment” cover

3. Asymmetrical composition with layering
layout. This approach asks a question to 4. Transparency with graphic type

engage the reader in what it means to be 9. Hope “spirit’ logotype
6. Hope logo 1s used on the back

‘

‘Fully Alive.”The “Your Moment” cover
pairs the question header with a singular

image that expresses dynamic movement.

o
o
0w
0

£ Hope coLLece

BROCHURE BACK

Hope

Chapel

LAYOUT TIP

Suggested
applications:

> Brochure cover
> Brochure inside
> Poster

> Direct Mail

BROCHURE COVER

o

4.6



Print Examples | Cover - Engaged Student ranD ApPLICATION 4.7

This application shows a suggestion of how  Features of the layout to note:

the brand elements can be used in combi- 1+ Full emotion photography

) . Y 2. Use of question header messaging
nation to create a “engaged student” cover

3. Asymmetrical composition with layering
layout. This approach asks a question to 4. Hope ‘spirit’ logotype

engage the reader in what it means to be ~ 9- Hope logo is used on the back

“Fully Alive.” The “engaged student” cover

pairs the question header with a singular

image that shows a student engaged in a

moment of spontaneous emotion.

« Hope COLLEGE

BROCHURE BACK

LAYOUT TIP

Suggested
applications:

> Brochure cover

> Brochure inside Center for

Faithful Leadership
> Poster
> Direct Mail

BROCHURE COVER



Print Examp|es | Brochure Spread

BRAND APPLICATION

This application shows a suggestion of Features of the layout to note:

how the brand elements can be used in

combination to create a brochure interior.

o0 O

1. Motion blur photography

2. Verlag and Clarendon in combination as graphic type
3. Large action word as graphic type

4. Subhead and body copy

5. Attribute photo

6. Layered transparency with color block

7. Asymmetrical photo layout

8. Enclosed icon

ACADEMICS

DIVE INTO YOUR CHOICE

F MORE THAN 80 PROGRAMS.

Hope Callege plays in the big leagues: Of nearly
1,000 colleges ranked according to the share of

their graduates who earn Ph.D.s, we are in the
top 1 percent in chemistry, the top 3 percent in

life seiences and the top 5 percent in all felds.

A surprising number of Hope students
undertake double majors, or majors and minors,
in unexpected combinations. Working at these
intellectual “intersections” can help them pursue
graduate study or work in pioncering arcas like

biotechnology, global politics and Christianity

in the Latino culture. Programs like Digital Arts
and the Humanities, a think tank like the
Center for Faithful Leadership and classes
like Communication and Conflict, which
blends textbook content, social media and
role playing, deepen understanding and
inspire innovative thinking.

With decades of externally funded student

research and the only private liberal arts college
nationally accredited in art, music, dance and

theatre, Hope sets the bar high. As a result, we're

aleading college for Fulbright Scholars, and our
students can look forward to attending their first
choice of graduate and professional schools:

CalTech, Harvard,

Princeton, University of Chicago, University of

orthwestern, Notre Dame,

Michigan and more,

ur teacher-scholars bring their disciplines to life

ACADEMIC PROGRAMS
Accounting
American Ethnic Studies
Arabic

At & Art History
Asian Studies

Ahletic Training

Biochemistry and Molecular Biolagy
Biology

Chemistry and Biochemistry

| Engineering
Blochamea Emphasis

Biomedical Emphasis

Chemical Emphasi

Civil Emphasis
EXPERIENCED MENTORS §I°M;""r55ﬂ-n<= Emphasis
AND WORLD CITIZENSHIP A
Our most experienced faculty teach first-year 5 :";::"""‘ Emphasis
tly Environmental Studies

and introductory courses and become

1.8

mentors to students. Dedicated to educating B
world citizens, they will encourage you to take Geological and Environmental Sciences
advantage of Hope progra
D.C., Philadelphia, C
Oregon, which offer particular academic

ashington,

History
Interdisciplinary Studies
temational tudi

icago, New York and

emphases, and in global study programs on
several continents. Every freshman may begin

this cross-cultural education by applying to the

Phelps Scholars Program, a one-year academic/

residential program for students interested in
race and cultures, is
c Theory and History Emphasis
RESEARCH YOUR INTERESTS
We continue to be nationally recognized for
our commitment to undergraduate research.
Hope also ranks among the top 25 national
liberal arts colleges for the quality of teaching.
How do we stand apart? We believe that one of
your major research subjects should be yourself.

You begin by exploring personal goals in your

Seminar, and in the Sei

you articulate your world view in a self-reflective
paper preparing you for the next steps in your life

and car

. Ultimately, a Hope education
prepares you to take your place in the world
as a person of wisdom, heart and soul

institution de

in Putting Students First.

BROCHURE SPREAD




Print Examples | Brochure Spread BRAND APPLICATION

This application shows a suggestion of
how the brand elements can be used in

combination to create a brochure interior.

@ Face to_face: Faculty

Steve Bouma-

<.

MILES OF TRAIL

14

STUDENTS

1

PAIR OF HI

BROCHURE SPREAD

Features of the layout to note:

1. Asymmetrical photo layout

2. Object used for storytelling

3. Verlag and Clarendon in combination as graphic type
4. Transparency with graphic type

5. Enclosed icon

“From Genesis to On Steven Bouma-Prediger's bookshelf, ¢

he's written flank a hiking boot — one he wore
Revelation, the Bible . .

is a book of ecological
wisdom and a book
that calls us as humans

to care for the earth.”

atives. Hope offers a wide va

1.9




Print Examples | Brochure Spread sranp AppLicaTion 4.10

This application shows a suggestion of Features of the layout to note:

how the brand elements can be used in 1. Attribute photo

o ) ) 2. Analogous color scheme
combination to create a brochure interior. 3. Verlag and Clarendon in combination as graphic type
4. Illustrative icons

5. Asymmetrical composition with layering

ou a financial aid

lement your family

-

Fi!ntiél AidWAD ( DIRECT COS INDIRECT COSTS
Incomie Prbfile
of 2010-20

7 o tuition  szese0
1 Freshmt w5160
umber  Elig $3,780 '

$4,480 books,
(rech travel,
personal

N

$23,862-29,437
3!2,000-!9,&

951217730

$120,000+Over §7.472:15,600

Totals/Averages $19,701°
-, - . - .

BROCHURE SPREAD



Print Examples | Brochure Spread sranD AppLIcATION 4. 11

This application shows a suggestion of Features of the layout to note:

how the brand elements can be used in . AnalogouS.COIOr scheme
) ) 2. Asymmetrical layout

combination to create a brochure interior. . :
3. Information graphic

4. Illustrative icon

5. Enclosed icon

Fall Semester
Friday, September 30

Friday, October 14

Grand Rapids, Ml

Minneapolis, MN 40 minute drive

1.5 hour flight

Milwaukee, Wi Friday, October 21

2.5 hour ferry ride ool Fridey, October 28
Chicago, IL Friday, November 4
3 hour drive

Friday, November 11
Friday, November 18

i

Hope accepts the Common Application. It is recommended that
you apply early in the fall of your senior year. November 1 is our
Early Notification Deadline. Any complete application by this date
will be in the first group of files reviewed. Decisions for the Early
Notification group will be sent out by Thanksgiving. To be assured
consideration for merit-based scholarships, the Admissions Office

must receive a completed application by February 15.
@ hope.edu/apply

FINANCIAL AID AND SCHOLARSHIPS

Need-based financial aid. No student should rule out Hope
College because of cost. Our financial aid program awards more
than $30 million each year to help students afford Hope College.
Your eligibility for financial aid is determined by analysis of the Free
Application for Federal Student Aid (FAFSA) and the Supplemental
Application for Financial Aid (SAF). The FAFSA and SAF should be
submitted by March 1 for freshman and transfer students.

@ hope.edu/aid

and artistic scholarships that are not based on family
financial circumstances. Academic scholarships are
based on your classroom performance in high school
and SAT or ACT results. The Office of Admissions
must receive your complete application by February 15
to assure consideration for scholarships, including
Distinguished Arts Awards offered in Art, Creative
‘Writing, Dance, Music and Theatre.

Awards for Academic and Artistic Merit For
Freshmen Enrolling in the Fall Semester of 2012:

T'rustee Scholarship $17,000 per year

National Merit Scholarship  $17,000 per year
Presidential Scholarship $6,000-$15,000 per year
Distinguished Scholar Award $5,000-$6,000 per year
Valedictorian Scholarship — $5,000 per year

Alumni Honors Scholarship — $3,000-$4,500 per year

Distinguished Artist Award — $2,500 per year

@ hope.edu/scholarships

New York, NY
Los Angeles, CA Indianapolis, IN 2 hour flight
5 hour flight 4.5 hour drive Spring Semester
Monday, January 16
Friday, January 27
APPLYING TO HOPE Scholarships. Hope College awards academic Friday, February 3

Friday, February 17
Monday, February 20

Friday, March 2

Friday, March 30 (Junior Day)
Friday, April 13 (Junior Day)
Friday, April 20 (Junior Day)

@ hope.edu/visit

facebook.com/
hopecollege

@ ©0

twitter.com/
hopecollege

youtube.com/
hopecollege

B

BROCHURE SPREAD

lifehopeedu |




Print Examples | Brochure Spread BrAND AppLIcATION 4.12

This application shows a suggestion of Features of the layout to note:

how the brand elements can be used in . Use of question header messaging

2. Asymmetrical photo layout
combination to create a brochure interior. .
3. Full emotion photography

4. Enclosed icon

10| Hope

GLOBAL EDUCATION

Hope offers a wide variety of May and June

“Term courses, which allow four weeks of intensi

udy, sometimes combined with study abroad.

These initiatives demonstrate our deep
commitment to educating world citizens. They
also give students significant time with professors
like Dr. Annie Dandavar
91, who co-lead a May

d Dr.Joel Toppen

rm course to Rwanda.

Dr. Toppen says this course, “Hu

an Rights

and Human Wrong; ents the essence of

a Hope College educatio

“engaged, relevant,
combining the sp

al and cultural, and all of it

coming together into one expericn

Study abroad brings students face to face with
both outer and inne

lities. Tn the London May

Term, for example, “We're trying o understand
presuppositions you hold that are important in
how you see the world,” says Dr. Tom Smith.
When students return from study abroad, he
challenges them, “Don't

SELECTED MAY AND JUNE TERMS
RWANDA: H i

NDIA: The | i

— Do you just want
a variety of experiences,
or to learn how to
integrate them?

EDUCATING WORLD CHRISTIANS.
This kind of challenge reflects the fact that
Hope
Professor Jeff

fsses to treat people narrowly

says

- We've also defined our

Shristian liberal arts college in

mission as

global terms. “We want to grow students with
2 global consciousnes ritical discernment
writes Trygve D. Johnson, Dean of the Chapel,
able to thi respond to the big issues of

issues from poverty and structural racism

to environmental disasters,

As a Hope student, you develop this ability
through hands-on learning — experiences which

expand your view of the world and your bel

ef'in

the contributions you make. Jeffrey Vi

nburg '11
s texthook example. He has combined an
interest in conservation and sustainability with

volunte

teaching and internships, as well as
study and travel in
hat [last] t

hina and South Amer

a Fulbright,” he says, *

ince T had experien
ador teach

i 1d working in
ecology/sustainability

Of course it won't be enough for Jef

to teach English on his Fulbright assis

in Ecuador. He also plans to work with local

conservation and sustainability organizations

s solid

experience for his next carcer move.

on community-education pro

@ hope.cdu/study-abroad

This course, one of Hope's newest May Terms,
takes students to the cites,islands and highlands

of Scotland - but most memorably inside the minds
andhearts of the Scottish people. Equipped with
video cameras, Hope students explore the concept
of intercultural communication by questioning local
ravelers,studying how the medarepresent this
concept and reflecting on their own sense of culture,
faith and identity.

“Instead of writing a paper, we each made a 12-minute
documentary.”says Cara Green 13, who shot footage
while staying at a 6,000-year old abbeyfhostel.
“Ifocused on the difference betveen plgrimage and
tourism. The people shared such cool stories about
impactful moments on different journeys they had
taken? The course was just one experience of many
Cara has had at Hope where, she says, “People see
what | want to do and what Im capable of learning”

BROCHURE SPREAD




Print Examples | Three Panel Brochure BraND AppLIcATION 4.1E3

This application shows a suggestion of
how the brand elements can be used
in combination to create a three-panel

brochure.

Hope

Global Diversity

o O

THREE PANEL BROCHURE

Features of the layout to note:

1. Use of question header messaging

2. Full emotion photography

3. Word ‘Hope’ is large since logo is not present on front
4. Analogous color scheme

5. Clarendon used as graphic type

6. Asymmetrical photo layout

7. Asymmetrical composition with layering

8. Logo 1s used on back of brochure

' Hope COLLEGE




Print Examples | Insert Template sranD AppLicATION 4.14

This application shows a suggestion of Features of the layout to note:

how the brand elements can be used L. Full emotion phomgraphy_

) o ) 2. Clarendon used as graphic type
in combination to create an insert template. 3. Clarendon used as graphic type
4. Enclosed icon

5. Asymmetrical photo layout

FIVE REASONS
TO STUDY ART
AT HOPE COLLEGE

@ hope.edu/academic/art

INSERT TEMPLATE



Print Examples | Direct Mail BrAND AppLICATION 4.1

This application shows a suggestion of Features of the layout to note:
1. Clarendon as graphic type with 5. Layered transparency with

‘Live It header color block
2. Full emotion photography and 6. Attribute photo

how the brand elements can be used

in combination to create direct mail.

close-cropped photo 7. Icon used as an information graphic
3. Analogous color scheme 8. Use of vertical strips for
4. Motion blur photography photo layout

9. Logo is used on back of postcard

ACCEPTED
STUDENTS DAY

Hope.

ALUMNI
WEEKEND

April 27-28

OVERNIGHT 28 !
VISITATION ol STUDENT
- SERVICES

¢ 9

2011-2012

School Year

®
® O O 90909

POSTCARD TEMPLATE

& Hope COLLEGE

Office of Admissions
Holland, Michigan 49422-9000

e & OO




Print Examples | Poster sranD AppLIicaTION 4.16

This application shows a suggestion of Features of the layout to note:
how the brand elements can be used 1. Use of question header messaging
. o 2. Word ‘Hope’ is large

in combination to create a poster. 3. Full emotion photography and close-cropped photo
4. Transparency with graphic type

5. Asymmetrical photo layout

6. Attribute photos

& Hope COLLEGE

POSTER



Dlgltal Examp|es | Email Signature

This application shows how the brand

elements are used for the suggested

BRAND APPLICATION 4 o 17

Features of the layout to note:
1. Alternate HT ML typefaces are used for text formatting

2. Body copy is Arial Regular 12 pt. in Gray (#4D4F53)

email signature.

3. Sender’s name is Arial Bold 12 pt. in Hope Blue (#002244)

4. Sender’s title is Arial Italic 12 pt. in Gray (#4D4F53)

5. Hope College is Georgia Bold 12 pt. in Hope Orange (#F46A1F)

6. Address and phone number is Arial Regular 12 pt. in Gray (#4D4F53)
7. Sender’s email address and college url are Arial Regular 12 pt. in

Hope Orange (#F46A1F)

- Xala _Meeting Tomorrow

Ta: janafihope_ adu

| =7 Subject: Meering Tomarrow

Good marning,

Thanks,

Aliredd

Alredo M, Gonzaloz
Anenciaie Provass ana Danmn of
nremafanal and Moteenm Soeamian

Martha Millar Caniar

616.385.7850 | Zalesfhopa ad

090 O ¢

Piease et me lonow if 300 P wares for your schadule

dad Lolombla Avenwe, F.L. Box 8000, Holland, M 48422

EMAIL SIGNATURE
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Specia| Use Logos | Alternate Versions

There are special use versions of the
logo that may be used under certain

circumstances.

These alternate logos may be used for external
marketing purposes only. The addition of
cither the web address or the location of the
college serves to inform audiences who may be
unfamiliar with Hope College, such as those

who are outside the Michigan area.

The web address and location for the college is
always positioned as specified, below the logo
in a smaller type size. The type is Hope Orange
(PMS 166) for two color versions of this logo.

One color, black, reversals and use with screens
and photography should follow the same
specifications outlined in Sections 2.7-2.11 for the

primary logo.

The clear area for horizontal and vertical
orientation of both versions is the height of the
“0O” in ‘College’.

The mimimum size is based on legibility of

the text. The smallest size for the horizontal
and vertical orientations of the web address

logo are.4” and .5”. The smallest size for the
horizontal and vertical orientations of the

location logo are .4” and .5”.

Download special use logos at:

0 hope.edu/brand

WEB ADDRESS LOGO, TWO COLOR VERSION

& Hope COLLEGE

HOPE.EDU

MINIMUM SIZE

& Hope COLLEGE

HOPE.EDU _|

Minimum size: .4 high

LOGO STANDARDS

A.1

« Hope
COLLEGE

HOPE.EDU

« Hope
COLLEGE

HOPE.EDU

Mimimum size: .5 high

CLEARSPACE
(O [
& Hope COLLEGE! = Hope
S H.OPE_EDU! COLLEGE

LOCATION LOGO, TWO COLOR VERSION

& Hope COLLEGE

HOLLAND, MICHIGAN

MINIMUM SIZE

& Hope COLLEGE

HOLLAND, MICHIGAN

Minimum size: .47 high

CLEARSPACE

« Hope
COLLEGE

HOLLAND, MICHIGAN

« Hope
COLLEGE

HOLLAND, MICHIGAN

Munimum size: .5” high

HOLLAND. MICHLGAN




Specia| USG Logos | Department

There are special use versions of the
logo that may be used under certain

circumstances.

These department logos are examples of the
shortest and longest departments. This format
may be used to create logos for all department
on campus. This version is intended for use
by the specific department only in print and

environmental applications.

The department name may only be used with
the horizontal version of the logo. The name is
always positioned as specified, below the logo in
a smaller type size. If the department name is
long it may be broken into two lines. If possible,
please refrain from breaking the type so there
1s a single word on the second line. The type is
Hope Orange (PMS 166) for two color versions
of this logo.

One color, black, reversals and use with screens
and photography should follow the same
specifications outlined in Sections 2.7-2.11 for the

primary logo.

The clear area is the height of the “O” in
‘College’.

The mimimum size is based on legibility of the
text. The smallest size for one- and two-line

version of the logo is .4” and .5” high.

Download special use logos at:

0 hope.edu/brand

LOGO STANDARDS

HORIZONTAL DEPARTMENT LOGO, TWO COLOR VERSION

& Hope COLLEGE

CAMPUS SAFETY

& Hope COLLEGE

ECONOMICS, MANAGEMENT
AND ACCOUNTING

MINIMUM SIZE

& Hope COLLEGE

CAMPUS SAFETY

& Hope COLLEGE

ECONOMICS, MANAGEMENT
AND ACCOUNTING

CLEARSPACE

© Minimum size:
{47 high

Minimum size:

.57 high

DEPARTMENT OF ECONOMICS‘
L ,,,,,,,,,,,,,,,,,, MANAGEMENT & ACCQUNTING

A.2



Specia| USG I_OgOS | Department

VERTICAL DEPARTMENT LOGO, TWO COLOR VERSION

< Hope

COLLEGE

CAMPUS SAFETY

MINIMUM SIZE

« Hope
COLLEGE

CAMPUS SAFETY

Munimum size: .5” high

< Hope

COLLEGE

ECONOMICS,
MANAGEMENT
& ACCOUNTING

« Hope
COLLEGE

ECONOMICS,
MANAGEMENT
& ACCOUNTING

Munimum size: .6875” high

CLEARSPACE
Q. Q e,
« Hope « Hope
COLLEGE COLLEGE
.CA_MRU_S_SAEE_'[YJ F_ CONOMIC S,.
MANAGEMENT
& _ACCOUNTING

Download special use logos at:

0 hope.edu/brand

LOGO STANDARDS

A.3



Special Use Logos | Logotype Only

There are special use versions of the
logotype that may be used under certain

circumstances.

Marketing/Spirit Logotype
The marketing/spirit logotype may be used when
a larger, more powerful graphic version of the

logotype is desired for a marketing communication.

This logotype may not appear without either
type of the ‘Live It’ messaging or an identifying
subhead (such as ‘Academics’). Messaging or
subheads may use Verlag Book or Bold, and

can appear as one or multiple lines of text. See
Appendix A.14 for further detail on this type of
messaging. The logotype must also appear in
combination with the entire Hope logo either on
the top, bottom or back of the piece.

Color specifications for the marketing/spirit
logotype must follow the horizontal and vertical
versions of the logo ( see Sections 2.7-2.11). The
marketing/spirit logotype may also be screened
to a percentage of no less than 80% white.
Clearspace is based on the height of the ‘O’ in
‘Hope’. The ‘Live it.” messaging and identifying
subheads are excluded from this clearspace
regulation. The minimum size is based on the

legibility of the type. For the full logotype, the

type should be no smaller than 7 pt. or .125” high.

Full Logotype

The full logotype without the icon may be used
in exceptional circumstances when the icon is
unable to render using the desired production
methods. An example of this is when the

size requirement for the logo is less than the

minimum size (.3”), such as on a pen.

Color specifications for the full logotype must
follow the horizontal and vertical versions of
the logo ( see Sections 2.7-2.11). For the Hope
logotype only, the clear area is the height of the
‘O’ in ‘Hope’. The minimum size 1s based on
the legibility of the type. The type should be no
smaller than 7 pt. or .125” high.

A4

LOGO STANDARDS

MARKETING/SPIRIT LOGOTYPE

MARKETING/SPIRIT LOGOTYPE SUBHEAD SPACING

Hope

Financial Aid,

no greater than

Grants, Loans,
and Campus Jobs

baseline of type

Left spacing of subhead is equal to distance
from the baseline of ‘Hope’ to top of subhead (y)

CLEARSPACE MINIMUM SIZE

Minimum size:

: Ope 1257 high

FULL LOGOTYPE

Hope COLLEGE

CLEARSPACE MINIMUM SIZE

Minimum size:

125" high

........................

Hope COLLEGE 1

Download special use logos at:

0 hope.edu/brand

-- Height of subhead text
1/4 of 0’ (x) in ‘Hope’

== Bottom of p’ matches



Special Use Logos | icon Only

The icon may be used by itself under certain
circumstances. Permission must be obtained
from Integrated Marketing for use of the

anchor icon by itself.

The anchor icon may be used when the context

clearly references Hope College.

The icon may only be used in Hope Orange (PMS
166) or Black River Black. No tints are permitted

for use.

Reversals of the icon may be used as long as the
background color continues at least one icon
width past the edge of the icon.

The Hope logo must always have a clear space
around it, where no other elements appear.
Clearspace for both icons is half of the icon height
for all sides.

The mimimum size is based on legibility of the
icon. The smallest size for the anchor icon is .25”
high.

Download special use logos at:

0 hope.edu/brand

LOGO STANDARDS

ANCHORICON

SOLID COLOR REVERSALS

& @

Anchor Icon

YA

Anchor Icon

CLEARSPACE

1/2 icon
height

Anchor Icon

MINIMUM SIZE

(@ 1 Minimum size:
T 257 high

Anchor Icon

A.5




PhOtOg raphy | Concept

Three types of concept photography
are used - Motion Blur, Close-Cropped

Profiles, and Full Emotion.

MOTION BLUR

BRAND IDENTITY Ao6

Motion Blur Photography

This photo style captures the dynamic energy that surrounds the
Hope experience. This technique can also be used as a portrait
style that captures the singular experience of a person within the

context of their environment.

Close-Cropped Photography
This photo style creates a tight graphic focus. The subject appears

moving just out of the frame of a photo, as if caught mid-motion.

CLOSE-CROPPED PROFILES




PhOtOg raphy | Concept

Three types of concept photography
are used - Motion Blur, Close-Cropped

Profiles, and Full Emotion.

FULL EMOTION: BOLD

BRAND IDENTITY A.7

Full Emotion Photography

This photo style highlights the unique emotional energy at
Hope within a full array of experience. The emotional impact
1s heightened by intensifying it in a vibrant color with the photo

overlaid in black and white.

Use of this photography style can be either bold or subtle depending
on the need and context. For example, a bold use of this style is
more appropriate for prospective students, while a subtle use is
more appropriate for donors. The styles can be mixed and matched

depending on the need of the layout.

The bold style should use the background color and the grayscale
photo at 100% intensity. The subtle style can use between

40-80% tint of the background color and 40—-80% transparency

of the grayscale photo. Enough contrast must be left between the
background photo and color to be able to see the subject of the photo.

Tip: See Appendix B.1 for how to create these photographic effects.




Photography | Layout

There are two ways to approach
photography layout. One is to use
asymmetrically composed photos that are
tightly spaced. The other is to crop photos
vertically in thin strips. Both types of photo
layouts use spacing between the photos of

exactly 1/16” (0625 inches).

ASYMMETRICAL COMPOSITION

Develop
your capacity
for fun

BRAND IDENTITY Ao 8

Asymmetrical Composition

This approach is best used with multiple images and offers the
greatest flexibility in terms of size and orientation of imagery. It is
important to have one larger image that is the focal point and at
least two smaller supporting images. Photos may either be directly

aligned with each other or overlap.

Vertical Strips

This approach is best used with vertically oriented photography.
Either one strip or tightly spaced multiple strips may be used. When
using multiple strips, it is important to have one larger image that

1s the focal point. These photos directly align with one another and
typically bleed off of at least one edge of the page.

Both of these approaches may be combined to add more

visual interest.

opportunities

COMBINATION OF BOTH

| Carigus,

o | —T

[ 1= T
o' Hope COLLEGE

CAMPUS LIFE




G raphics | Typography

The brand relies on text for graphic
impact. Layouts should use multiple
typefaces and weights to provide texture
and interest on the page. Text should
not be used decoratively; it is important
that the graphic text relate important
information and maintain clear hierarchy

within the layout.

VERLAG AS A GRAPHIC

CLARENDON AS A GRAPHIC

VERLAG AND CLARENDON IN COMBINATION

ACADEMICS

BRAND IDENTITY Ao 9

Verlag as a Graphic
Any weight of Verlag may be used as graphic text. The text may be
title case, sentence case, upper case or lower case. Graphic numbers

should not use Verlag if they are over 24 pt.

Clarendon as a Graphic

Only Clarendon Roman, Bold and Black may be used. The
preference is to use lower case for all graphic text with the
exception of proper names and sentences. Upper case is not
permitted. Graphic numbers above 24 pt. should use

Clarendon only.

Clarendon and Verlag in Combination
Clarendon and Verlag may be used in combination as graphics,

however one typeface must be dominant over the other.

17



G raphics | Iconography

cons may be used to call out or visually

connect important information on the page.

Icons should always be simple and two-
dimensional, containing no drop shadows,
bevels or reflections. All icon sets exist for

use with both print and/or web materials.

This set may be expanded to include purchased
or created icons as long as they maintain the

same look and feel.

lllustrative Icons

Illustrative icons may be used as a stand-alone
graphic or in conjunction with information
graphics. They are helpful when used to direct
attention to specific information on a page,
such as tuition cost breakdowns or ways to

travel to Hope College.

Enclosed lcons Including Social Media
Enclosed icons signify a web link that leads
you to more information. Enclosed icons come
in two types: one for print- and email-based
applications and the other specific for web-

based.

Print- and email-based enclosed icons are
always a white icon in a Hope Orange (PMS
166) circle. Exceptions to this format occur
when there is too little contrast between the
circle and the background. In this case an
appropriate color or white must be chosen for
the circle (see Section 3.1-3) to ensure contrast
with the background color. The icon must be
changed to match the background color.

Web-based icons are used only on the website.
This icon set is comprehensive and includes
all social media outlets. Currently, Hope
College’s only approved social media channels
include Facebook, Twitter and YouTube.

BRAND IDENTITY A. 10

ILLUSTRATIVE ICONS

® PO
'@ W

ENCLOSED ICONS, PRINT-AND EMAIL-BASED

® O @ 6006

Link Download  Student Life Facebook Twitter YouTube

@ hope.edu/brand

Enclosed anchor icon with white anchor (not transparent).

Enclosed anchor icon with orange anchor (not transparent).

ENCLOSED ICONS, WEB-BASED

Bl & &

Facebook Twitter YouTube

Request icons at:

0 hope.edu/brand



Graphics | Information Graphics and Objects

There are two more types of graphics
that may be used in conjunction with

the rest of the brand elements:

lcons and Information Graphics

Information graphics may be used to visually
relate important information on the page.
Examples of this are typical bar charts, maps
and graphs.

Information graphics should always be simple
and two-dimensional, containing no drop
shadows, bevels or reflections. Spacing between
parts of the graphics should be 1/16” (.0625
inches).

Objects

Photographs of objects may be used to add
more visual variety on profile/storytelling
layouts. These images provide an additional
layer of information for the reader and
highlights the complexity and dynamism

of the subject matter.

The objects should have a clipping path and a
drop shadow. Objects may rest on either a color
or white. Tip: The drop shadow must be at no
more than 20% opacity, no more than .05”
distance from the object and between 120 and
160 degrees.

BRAND IDENTITY A.. 1 1

INFORMATION GRAPHICS

p

Y
o

PHOTOGRAPHIC OBJECTS AS STORYTELLING GRAPHICS

™ Ny




Layout | Grid sranp IDEnTITY AL 12

The underlying structure of the layout is A twelve-column grid is used for maximum flexibility in layouts.

. . . This allows for either even or odd numbers of columns across a page.
just as important as the graphics, type

and photography of the brand. The grid provides the structure for the organized placement of
elements on a page and in relationship to each other. Use the grid as

the guide for sizing of all text boxes, photos, captions and call-outs.

Grid sizes for standard formats are available for download.
See Appendix B.2 for how to create a 12-column grid using any

document format.

revel

in friendship

“The faculty know
us so well. They
have been able
to challenge me
to play off my
strengths and

strengthen my

weaknesses.”

— Christopher Jackson,

Ko or,

? hope.edu/about




Layout | Composition sranp iDenTTY AL 13

Hope College is a dynamic, exciting place An asymmetical composition can still achieve a visual balance

without the elements being equally spaced or weighted.

to learn. An asymmetrical composition . _
Tip: Choose an element to serve as the focal point for the

creates more interest and tension between layout, make it the dominant size, and place it off-center in the

the graphic elements to translate the composition. Use the underlying grid to align the remaining

Hope experience elements in relationship to each other. This will keep the layout

balanced, organized, and provide an information hierarchy.

ASYMMETRICAL COMPOSITION




Layout | Layering sranpipentiry A 14

Layering graphic elements evokes the OVERLAPPING ELEMENTS

movement and vitality of the students,

HOPE

faculty, staff and overall environment at

SPORTS

Hope College.

Overlapping Elements

Areas of color, photos, type and graphics can
align and overlap in many ways. Make sure
visual hierarchy is maintained and all photos

and text are legible when layering elements.

Transparency

Adjusting the transparency of an element can
also be used to increase the effect of layering.
Transparency can occur either as a graphic

type treatment or a block of color.

Transparent graphic type can be layered either
over photography or other elements on the
page. The type must be always be legible when
used with transparency. Refrain from using
this technique on type that is below 30 pt. in

size or is too thin to be legible.

Transparent blocks of color may be used to
increase the amount of color on a page, provide

emphasis for an area and/or provide a space for

type to layer over a photo. Type must always
be legible when using a transparent color block
over photography.

TRANSPARENCY WITH COLOR BLOCKS

® hope.cdufresearch




Messaging | Live It Header

Live It Headers are a messaging element
within the brand palette designed to pair
with the singular Hope “spirit” logotype.
These short, definitive statements
reference “Hope” as both a College and
an ideal. The energy of the statement

expresses the “Fully Alive” concept.

Statements should always be limited to two or
three words and end specifically with the word

“1t.” The statements can be crafted in two ways:

> in the Verlag typeface as a subhead, smaller

and subordinate to the Hope “spirit” logotype.

> in the Clarendon typeface in equal weight to
the Hope “spirit” logotype.

— |
i -
= OVERNIGHT

VISITATION

LIVE IT HEADER MESSAGING

STUDENT
SERVICES

2011-2012

BRAND IDENTITY A. 1 5

ALUMNI
WEEKEND

April 27-28



Messaging | Question Header

Question Headers are a messaging
element within the brand palette
designed to engage the reader in their

own assessment of what it means to be

“Fully Alive.”

The question header as a messaging tool is best
when some set-up and exposure to the College
brand has previously taken place.

A question header could typically be used on

a marketing piece within a communication
sequence where an individual has already
received some College communication that
includes the “Fully Alive” expression of campus
life, people and dynamic movement. A question
header could also be used in combination with

these other ideas on the same piece.

Questions should be crafted to be succinct, direct

and thought-provoking. The best questions will

be between five to seven words in length.

BRAND IDENTITY A. 16

QUESTION HEADER MESSAGING

VidIT QFTIGHE
R mIHIGEE
AND SEHIBRE

Ao g R e g
gL - dmm
| g dre L i
L e PR e

R BT T SR 1 e
L R e ] 40P P ST

LrapaH W 0 A P RS F S 8

s i = 0000




Messaging | Action Word sranp iDenTTY AL 1'7

Action Words are a messaging element ACTION WORD MESSAGING

within the brand palette designed to

communicate the “Fully Alive” spirit that

“The faculty know At Hope, the liberal arts are about asking

brings the Hope campus to life. e e, the i questionsinan apen amosphre,

and about asking oneself, “What do I

to challenge me X 3 .
believe? What is my world view?” As an
to play off my
e inclusive Christian community, Hope
S S teaches students o balance passionate
AIl ACthIl WOI‘d 1S a Slngle Word trcated B Aeseeet convictions with respectful discussion,
Christopher Jackson,  and to strengthen the values and
as graphic text. It serves as a point of g e relcionships that an susain them.
The result? Gifts and skills turn into not
communication emphasis within a layout. ot careers, but meaningul vocations.

Multiple Action Words may be used in a layout,
. . to the challenge
however they must be consistent in size and

approximate length. There are two ways actions

can be used:

> as a graphic word that is part of a crafted

headline and is necessary to complete

the message

> as a graphic word that screens back behind K

text and highlights the topic, but is not required Stitup in Orange and Bloe
to complete a headline or subtext. The action

Hope belongs to the Michigan hlei i he oldes of
word only serves as a point of emphasis for T o W D
the topic. Do e A, el s 25t 52 A Spors v

inits MIAA conference. In 2010-11 Hope athletes and/or eams qualifid for eight NCAA
championships.

Club sports arc making their mark, too. Our ice hockey team finished the 2011 scason
. . o A T
Action words should be applied within a layout oo e e sy . St ek s et

of experience, who compete at regattas almost every weekend throughout the Midest

using a tint of the primary or secondary color e e e
palette. See Section 3.1-2 for how to correctly —

choose tints to create action word graphics.

LI e )




Detail | Profile Treatments sranD appLIcATION A 18

Profile treatments can vary depending on Features of the layout to note:

the length of text. These are three solutions I Verlag used as graphic text

2. Information graphic numbers profiles

for profiles of varying length. 3. Motion blur photography

4. Full emotion photography and close-cropped photo

5. Enclosed icon

FULL SPREAD PROFILE

Daniel Owens '13:
[T ——

go Romero 09

MINIPROFILE QUARTER SPREAD PROFILE



Detai| | Trajectory Treatment

Trajectory treatments may occur in either

print or web applications.

Features of the layout to note:

1. Close-cropped profile photography
2. Clarendon used as graphic text

3. Object used for storytelling

BRAND APPLICATION A. 1 9

Michael Bass

Majors in Communication -
Minors in Leadership .
T~

Coordinating
branding project

for Hope
Entrepreneurship
Initiative

Performs with
Hope College Jazz Ensemble
and Blue Note Ensemble

Plays rock and rollin
the Kletz vith his band,
Stationary Travelers

-
S Books college concert
— 1! series for Lemonjello’s

— coffee house

What's a Moodle?

slang that means
in your head for
awhile to look at different

ts of it

B) Hope's open-source course
management system (CMS), where

your teachers upload assignments,
hold discussions online, give online

quizzes and surveys, and record grades.

AWARD-WINNING COMMITMENT.
Hope students volunteer in many ways, such

as mentoring local youth who need positive role
models, working with area churches, spending time
with seniors during the Moonlight Serenade Miser

at an area nursing home, and helping o,

nearby
food pantries. The depth of service projects by
Hope's Alcor Chapter of the national Mortar Board
honor society won that organization's highest honor
2010, and in 2011 Hope

for a collegiate chapter

e of only 115 colleges and universities natior

wide honored for its community service and soci

ancement of Teaching. Our cight sororities and

seven fraternities take social responsibility to heart,

organizing many events to support speci

Further aficld, ongoing projects regularly take
groups of students and faculty to Jamaica (working
with deaf children) and Cameroon (providing clean
eak

drinking water), and during our 2071 5
st

ed in 14 different locations, from

California to Florida and South Dakota to Latin
America. “Each mission trip has ts own unique
focus,” says Beverly Newey 11, “and Hope docs
a good job of matching you with a trip based on

your inerests.”

e

Cool Beans Coffeehouse
The Kletz

Cup and Chaucer

PRINT TRAJECTORY TREATMENTS

Volunteer and Service | 7
h 1

In China, reads a book

sbout Hopeby themother o g —
of Dan Tian 08

H Enrolls at Hope as a Phelps Scholar
Visits with leaders in business,

economics, government and

social policy through the

Baker Scholars Program

Interns at Holland Area
Chamber of Commerce and

Stryker Corporation in
Kalamazoo, Michigan

Promotes cultural activities
as President of International
Relations Club

Picks up basic
Japanese on May Term
=7 inTokyoand Osaka

Gives keynote
address at Hope's
Model U.N.

Plays coed intramural
volleyball and
women’s badminton




Special Initiatives

A special initiative, such as a Capital
Campaign, will sometimes require a
custom approach because the marketing
intent is more strategically targeted.
Layout and composition should draw
from elements of the primary College
brand palette, and a modified ‘look

and feel’ must be complementary and
cohesive. Here are suggestions for
applying brand elements to a Special

Initiative campaign.

Photography

The audience of the initiative should be kept

in mind when choosing both general and
concept photography. For example, close-
cropped, portrait-style photos combined with
the script typeface might be more approachable
for fundraising with a mature, professional
audience. In contrast, the bold style of the

full emotion concept imagery may be more
effective with recruiting a high-school-age

prospect.

Typography

If the initiative has its own primary typeface,
the primary typeface for Hope (Clarendon)
may become a secondary typeface. In this
case Clarendon may be used for subhead or
headlines only. The primary typeface should
be used as the display typeface.

Color

If there are any colors in addition to the
primary and secondary brand colors they
should be incorporated with the palette as a
secondary color only. This ensures consistency

through the dominant use of orange and blue.
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Poster | Brand Specifications

Co-operative marketing opportunities
are where the Hope College brand exists
in relationship to a separately-defined
entity, program or event. Examples might
include Nykerk or Dance Marathon. In
these cases, the Hope brand must appear
in the design and be clearly-identifiable,
but may be secondary in the information

hierarchy.

A dedicated space must be established to clearly
identify the Hope brand and position the
College’s relationship to the opportunity.

Basic templates are provided for these poster
and flyer applications to insure the correct
representation of the Hope brand while allowing
activity creators the necessary freedom to

effectively address their audiences.

The dedicated brand space for each audience
type may be used in either Hope Orange (PMS
166), Hope Blue (PMS 289) or Graves Hall
Gray. Please take the overall poster design into

account when choosing a suitable color option.

BRAND APPLICATION

EXTERNAL/INTERNAL AUDIENCE POSTER

RIVER NORTH
CHICAGO DANCE

& Hope COLLEGE

Hope College Great Performance Series

Ticket Offic

& Hope COLLEGE ® HOPEEDU/ARTS

Download dedicated brand space templates at:



Digital Examples | Basic Email Template srAND APPLICATION AL . 22

This application shows a header and footer Features of the layout to note:

that can be used to create basic HTML 1. ‘Live It header paired with ‘spirit’ logotype

) 2. Motion blur photography
emails. Arrangement of the photos and copy

3. Use of vertical strips for photo layout

in the middle will vary depending on subject 4. Attribute photo

matter and email management system. This 9 HTML text used for headlines, links and body copy
header and footer may be used for all Hope

College e-communication.

aaHope

Learn it. Love it. Live it.

oo

Us et versped ut re nam uciet lorem ipsum

Ugiae verspiti dent iumenda dunt untis abo. Ugiae verspiti dent iumenda dunt untis
abo. Atatqua turehendiore nim quae assinimpos non restionetum qui odi dolupta turepu-
dic te odis as imus dunt et placcus in core sequam nonsecae escilibus nemodit dollitatur,
sit omni officie ndigenim numquos que dolorup tiisquo idit apero tenihilique pedione
mostionest facia sitatqu aerepudis exero omnihiti que nim ea cusam, con nis eosapide ilis
solupta dolorest dic te odis as imus dic te odis as imus?

See more about study abroad »

o ———Equassitiis dolesse quiscid ma

Ugiae verspiti dent iumenda dunt untis abo verspiti dent iumenda idium unum.
Ugiae verspiti dent iumenda dunt untis abo. Atatqua turehendiore nim quae assinimpos
non restionetum qui odi dolupta turepudic te odis as imus dunt et placcus in core sequam
nonsecae escilibus nemodit dollitatur, sit omni officie ndigenim numquos que dolorup
tinim ea cusam, con nis eosapide ilis solupta dolorest, volupti comnis ducid est fugitam
nones quatatur? Quisquat.

See more about Majors and Minors »

69 East 10th Street, PO BOX 9000, Holland Ml 49422

& Hope COLLEGE 5009687350 | hopa.ada

EMAIL TEMPLATE

Download header and footer templates at:

o hope.edu/brand



T—shirt | Brand Specifications

Co-operative marketing opportunities
are where the Hope College brand exists
in relationship to a separately-defined
entity, program or event. Examples might
include Nykerk or Dance Marathon. In
these cases, the Hope brand must appear
in the design and be clearly-identifiable,
but may be secondary in the information

hierarchy.

A dedicated space must be established to clearly
identify the Hope brand and position the
College’s relationship to the opportunity.

Basic templates are provided for poster, flyer
and t-shirt applications to insure the correct
representation of the Hope brand while allowing
activity creators the necessary freedom to

effectively address their audiences.

T-shirts

There are three identifier options for T-shirts.
The first displays the Hope logo on the upper
left chest area, with the branded event/
program logo and graphics on the back. The
second displays the branded event/program
logo and graphics on the front and the Hope
logo on the back. The third option keeps the
Hope logo on the left sleeve and the event/
program logo and graphics on the front and/

or back.

The same specifications apply for the logo when
it is used on a T-shirt. Please see Section 2 for

all specifications regarding logo usage.

Tip: If budget restrictions don’t allow for a
two imprint shirt, please contact Integrated
Marketing for assistance on an alternative

design.
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GRAPHICS ON FRONT, HOPE IDENTIFIER ON BACK

COLLEGE

HOPE IDENTIFIER ON SLEEVE, GRAPHICS ON FRONT
AND/ORBACK
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Creating ‘Full Emotion” Photography

APPENDIX B. 1

Use of this photography style can be either bold or subtle depending on the need and context.

Please read Section 3.12, which covers full emotion photography usage before you begin.

INPHOTOSHOP

1. Select the photo you wish to use

Photo selection will vary depending on the topic. Please select
imagery that shows an emotion appropriate to the subject and
tone you wish to convey—joy, determination, concentration,
peace, etc. The photo may or may not be a close-cropped

profile of a person (see Appendix A.5). Generally, more simple
images work best as a larger scale photo such as a cover or poster.
Secondary images in a layout may be simple or slightly more
complex. Keep in mind that the photo will be reduced to grayscale

and therefore some detail may be lost with the color change.

2. Change the photo’s color to ‘Grayscale’

In the top bar, select Image > Mode > Grayscale. The computer
may ask if it is OK to discard color information. Click the ‘OK’
button.

3. Increase the contrast of the image

In the top bar, select Image > Mode > Adjustments > Brightness/
Contrast. Make sure the ‘Preview’ box is checked. Grab the arrow
under the ‘Contrast’ bar and pull it to the right. This will increase
the contrast of the photo. Find a good balance of high contrast
without loss of detail in the photo. Click ‘OK’ once you are
satisfied with the result.

4. Save your photo with a different name

It is often helpful to keep the original file name and simply add an
extra couple of characters to designate it as a grayscale file. An
example is to add "_bw’ at the end. This way you can reference the

original file if necessary.

5. Switch over to your layout in InDesign

ININDESIGN

1. Create a background color

Use your rectangle tool to create a background color for

the photo. The color may be used at either full strength or a
permitted tint of a color may be used (see Section 3.3). This
decision should be based on the other colors within your layout as
well as the ‘style’ of full-emotion photography you wish to use
(see Appendix A.6).

2. Place your photo
Draw a photo box over your colored background. This box should
be the same size as the background. Select File > Place and

browse your computer to find the image you just created.

3. Size your photo
Using the Direct Selection tool, enlarge or shrink your photo

within the photo box to the desired crop.

4. Change Transparency to Multiply

Select your photo using the Selection tool, then select

Object > Effects > Transparency from the top bar. Under the
“Transparency’ header in the dialog box, use the drop-down
menu to select ‘Multiply’. Select OK. This effect application
should remove white from the photo, leaving only black with the

background color showing through.

5. Make adjustments
You may wish to make some additional adjustments at this point

based on the ‘style’ of full emotion photography you wish to use.

For Bold Style: Leave the background color and the grayscale
photo at 100% intensity.

For Subtle Style: Either the intensity of the background color

or the grayscale photo may be altered. You may use between
40-80% tint of the background color and 40-80% transparency
of the grayscale photo. Enough contrast must be left between
the background photo and color to be able to see the subject

of the photo. The transparency can be adjusted by selecting

the object and adjusting the sliding arrow back and forth under
“Transparency’ in the top bar. Tints can be adjusted at the top of
the swatch palette (turn on under Window > Swatches in top bar).



Creating a Grid Using Any Format

Although grids for standard document sizes
are supplied, you may wish to create your own

grid based on a non-standard document size,

APPENDIX Bo2

ININDESIGN
1. Create your document to your preferred dimensions and

margin sizes

2. Find your Master Page

If you set up a grid on your master page, the grid will appear
throughout your document where you have used that page. If you
follow these instructions on a single page of the document, the

grid will only appear on that one page.

Master pages are displayed at the top of your ‘Pages’ palette.
Click on ‘A-Master to access this master page’s layout. Note: if
you make another master page type, you will have to repeat steps
2-3 to make a grid for this type of page.

3. Create your grid

In the top bar, select Layout > Create Guides. In the dialog box,
choose 12" as your number of columns and either use the default
gutter width or select your own preference. Under ‘Options),
choose the ‘margins’ button instead of the ‘Page’ button. This
should create 12 equally-sized columns for each page of your

document.



Print Production Speciﬁcations APPENDIX .3

Production specifications provide
consistency between multiple printed
pieces. Paper and color are the two

important tactile and visual cues of a brand.

Paper Specifications
Printer’s house sheet or an equivalent is fine for standard printing.

A higher grade sheet is recommended for stationery suites.

Postcards, covers, brochures and accordian-style folding pieces:
80# Cover White Matte or Silk Coated

Interior pages of saddle-stitched brochures and inserts:
80# Text White Matte or Silk Coated

Envelopes:

70# or 80# Text White Uncoated

Cards that contain forms:
80# Cover White Uncoated (for ease of filling out form with pen)

Color Specifications

Orange 1s the most distinguishing brand color of the two primary colors.
One-color pieces should use either orange or black. Two-color pieces
should use orange and blue. If any element of the layout is unable to render
in blue, black may be used instead. Any pieces with full-color photography
must use four color process. If any piece has heavy coverage or very fine
detail (such as small type) in any color other than black a spot color is sug-
gested for best printing quality. An aqueous coating is suggested with all

pieces run on a coated sheet.
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